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1

Introduction
®

Welcome to CoDeSys@CHIP, the IEC61131-3 programming environment for the IPC@CHIP
family. CoDeSys is one of the most powerful Windows-based IEC61131-3 programming tools
available for industrial controllers. The implementation of CoDeSys@CHIP provides the
®
opportunity of programming in IEC61131-3 on the IPC@CHIP platform, including all the
®
IPC@CHIP processor functions in hardware and software.
CoDeSys is the name of the IEC61131-3 programming environment running on a Windows PC.
Developed by the company 3S – Smart Software Solutions GmbH, it is available for free. You
can
download
the
setup
for
the
CoDeSys
Programming
system
on
http://www.beck-ipc.com/codesys.
®

To get your IPC@CHIP CoDeSys compatible you need a respective Run Time System (RTS).
®
The RTS will be executed on the IPC@CHIP . It manages the whole communication with the
®
CoDeSys Programming System on your Windows PC. The RTS for the IPC@CHIP is also
available on http://www.beck-ipc.com/codesys.
®

In order to have full CoDeSys functionality an IPC@CHIP with the -IEC extension is required.
®
The IPC@CHIP SC1x-IEC, SC23-IEC and SC1x3-IEC series include the required CoDeSys
RTS license. In case you already have a standard SC11, SC13, SC23, SC24, SC123, or SC143
(without the -IEC extension), it is possible to use it for testing purposes with full functionality,
only limited by time (4 hours). The Development Kits DK51, DK55 and DK61 (DK51 and DK61
are used as reference hardware throughout this manual) the Software Evaluation Kit EK61
®
include an IPC@CHIP with the -IEC extension. They are delivered with a SC13-IEC, SC23-IEC
and SC143-IEC processor respectively.
®

This document provides a step-by-step guide on how to put the IPC@CHIP and CoDeSys into
operation and concentrates on a system level start-up. For more information on hardware and
®
software functionality please also read the IPC@CHIP Documentation and CoDeSys
Documentation provided by 3S.
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The IEC Platform Concept

CoDeSys is a hardware independent Programming System which can be adapted to any industrial
controller. To adapt CoDeSys means to create a software collection which describes and handles the
hardware of the industrial controller. The software collection which adapts CoDeSys to a specific
®
IPC@CHIP hardware is called the IEC Platform.
With CoDeSys@CHIP we provide a powerful and easy-to-use development kit to create IEC Platforms
®
for your specific IPC@CHIP hardware. Also we provide ready-to-use IEC Platforms (e.g. for the
®
Development and Software Evaluation Kits). So you can start programming your IPC@CHIP in
IEC61131-3 immediately.
An IEC Platform is composed of two components:
1) The TSP (Target Support Package)
The TSP is a collection of files which describe hardware and software of a Target System
(PLC) to the CoDeSys Programming System. Installed on your PC, it represents a Target you
choose during the creation of the new CoDeSys Project.

2) The RTS (Run Time System)
®
The RTS is an application which runs on your IPC@CHIP processor's operating system
®
@CHIP-RTOS. It handles the communication between the IPC@CHIP and the CoDeSys
Programming System on your Windows PC. The RTS accepts the IEC application, which is
®
created with CoDeSys, and controls its execution on the IPC@CHIP hardware.
There are two variants of the Runtime System called "Full" and "Embedded". The Full-RTS
must be used with the SC1x3 and SC2x. It supports Multi-Tasking and is more comprehensive
than the embedded variant. The Embedded-RTS must be used with the SC1x (respectively
the DK51). It is smaller and does not support Multi-Tasking.

The IEC Platform Concept

The next chapter describes how to install an IEC Platform.

© 2010 Beck IPC GmbH
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Installing the IEC Platform

Before you start working with an IEC Platform, make sure that a valid CoDeSys Version is installed on
your Windows PC. You can find the latest CoDeSys Setup on http://www.beck-ipc.com/codesys or on
the Homepage of the developer company 3S (http://www.3s-software.com). For programming the
®
IPC@CHIP at least CoDeSys version 2.3.4.7 or later is required for SC1x processors and version
2.3.9.9 or later for SC1x3 and SC2x processors.
As described in the chapter before, the IEC Platform contains the RTS and the TSP. Both components
have to be installed. The next two chapters describe how to install them. The RTS will be installed on
®
the IPC@CHIP whereas the TSP will be installed on your Windows PC.
®

For your specific IPC@CHIP hardware you can create your own IEC Platform to manage the
®
hardware and peripherals of your IPC@CHIP application. With the IEC Platform Builder, it is very
easy to create an IEC Platform. The IEC Platform Builder is part of the CoDeSys@CHIP SDK. For
more Information have a look at the CoDeSys@CHIP SDK documentation (http://www.beckipc.com/codesys).
However, there is no need to create your own IEC Platform. If you use one of our
Development/Evaluation Kits, you can download a ready-to-use IEC Platform. Using such an IEC
Platform you have to follow the two simple installation instructions, described below. After that you can
®
immediately start programming your IPC@CHIP in IEC61131-3. You can find the IEC Platforms for
the Development/Evaluation Kits on http://www.beck-ipc.com/codesys.

3.1

Installing the RTS - Setting up your IPC@CHIP® Hardware
®

The RTS (Run Time System) is an executable file for the IPC@CHIP . Installing the RTS on your
®
®
IPC@CHIP means to download it to the IPC@CHIP processor's flash and start it. After that your
®
IPC@CHIP is accessible by CoDeSys and ready to run IEC61131-3 applications.
®

Before you can install the RTS on your IPC@CHIP , you have to set up the communication with the
®
PC. To do that, have a look into the Getting Started Manual for the IPC@CHIP Embedded Web
Controller Family (http://www.beck-ipc.com/chip). There you will find out how to set up the
communication, and download a program.
In general, an RTS contains two files:
1) *.EXE
– The Executable File
2) AUTOEXEC.BAT
– To Start the RTS (.exe) automatically after reboot
®

Depending on your IPC@CHIP , use the corresponding RTS in the branch named "Full" for the SC2x
and SC1x3 (DK55, DK61 and EK 61) or "Embedded" for the SC1x (DK51). Download the executable
®
located in the “RTS\BIN” directory to the flash of your IPC@CHIP (e.g. via FTP or X-Modem). Create
an Autoexec.bat file, containing the command line for the RTS to start it automatically. After the
download reboot it.

3.2

Installing the TSP - Setting up your CoDeSys Programming System
®

The TSP (Target Support Package) is a collection of files which describe your IPC@CHIP hardware
and software to the CoDeSys Programming System. By installing the TSP, the collection of files is
handed over to the CoDeSys environment.
The Installation of a TSP is very easy. You simply have to run the automatic installation file named
INSTALL.BAT.
Note that you may not install the TSP using the CoDeSys Target Installer! It does not handle
relative pathnames correctly. Using it leads to an incorrectly installed TSP.
To uninstall a TSP you have to use the CoDeSys Target Installer which you can find in the Windows
Start Menu next to the CoDeSys shortcut.
© 2010 Beck IPC GmbH
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The first project

Start the CoDeSys programming system via the Start Menu:
Start → Programs → 3S Software → CoDeSys V2.3 → CoDeSys V2.3

4.1

Writing the First Program

To get familiar with CoDeSys, you should follow the instructions below to create a simple CoDeSys
®
application and execute it on your IPC@CHIP hardware. The described application performs the
following purpose:
A running machine is to be observed by a machine operator. Correct running must be confirmed at
specified intervals. If there is no confirmation, a warning is first issued, shortly after which the
machine will be stopped. The machine moves an arm along a rectangular path, and completed
circuits are to be counted.
Don't forget to save your program now and then.
4.1.1

Step 1 - Creating a New Project

Starting is easy. Create a new project with the command File → New.
4.1.2

Step 2 - Target Settings

For our first project please select the entry which matches your IEC Platform (TSP and RTS) in the
combo box Configuration, e.g. DK51, DK61 or EK61. The abbreviation FP stands for Floating Point
support, CM stands for CAN Master Support.
4.1.3

Step 3 - The PLC_PRG POU

In the New POU dialog select the language FBD (Function Block Diagram) and retain the other
settings. The POU named PLC_PRG is a special one which is cyclically called and executed by the
run-time system in operation.
4.1.4

Step 4 - Declaration of the Confirmation Switch

We will start with the confirmation switch. Mark the three question marks (???) in the first network, and
type in the name of the switch (e.g. Observer). Now press the right-arrow key. The dialog which
appears for the declaration of variables contains the Name Observer and the Type BOOL. Alter the
Class to VAR_GLOBAL (for global variables). The variable is entered in the object for global variables
with OK. The following text appears there:
VAR_GLOBAL
Observer: BOOL;
END_VAR
4.1.5

Step 5 - Rising Edge of the Confirmation Switch

Everything is OK if the operator is there and confirms correct sequence of operation. That is, if the
switch changes from the off state (FALSE) to the on state (TRUE), known as the rising edge, or from
on to off, called the falling edge. We will start by determining the rising edge, i.e. whether the switch
changes from FALSE to TRUE. For this, we return to the PLC_PRG POU. Mark the location behind
the Observer variable, so that a rectangular marking appears. Execute the Box command through the
quick menu (right mouse button). A box for the AND operator is inserted and the name is marked.
Now call the input assistant with F2. You get a dialog, which offers all available operators. Select first
the Standard Function Blocks category and there the Trigger Function Block R_TRIG, which
belongs to the Standard.lib. R_TRIG reports the rising edges of a Boolean value, which in this case is
© 2010 Beck IPC GmbH
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our switch. An instance (data copy) of R_TRIG must be created. To do this, replace the three question
marks (???) which appear on top of the inserted box by the instance name (e.g. Trig1). After that
either click with the left mouse button behind the function block or press the right-arrow key. The
Declare variables dialog will appear where the Class VAR (for local variables), the Name Trig1 and
the Type R_TRIG are already entered. Press OK to enter the variable into the declaration segment of
the POU.

4.1.6

Step 6 - Falling Edge of the Confirmation Switch

Mark the location behind the function block (rectangular marking), execute the Box command via the
quick menu, and alter the designation AND to OR (logical or). Mark the line of the second input of the
OR-operator and insert a Box of Type F_TRIG for the falling edge, having the instance Name Trig2.
Mark the three question marks in front of the Trig2 function block, press the <F2> function key (input
assistance) and select the Observer variable in the Global Variables category of the dialog which
appears.
4.1.7

Step 7 - Time Monitoring, First Part

Insert a Box of Type TOF (switch-off delay) with the Name Timer1 behind the OR-operator using the
quick menu. Replace the three question marks at the PT input with the time constant T#10s for 10
seconds (the time can later be increased, after successful tests).
4.1.8

Step 8 - Issue Warning

Insert an Assignment behind the Q output of the Timer1 function block using the quick menu.
Replace the three question marks with the variable name Warning. In the declaration of variables,
enter the Class VAR_GLOBAL and the type BOOL. So that the warning is indeed properly given,
mark the first position on the assignment and execute the Negate command via the quick menu. This
causes the Boolean signal to be inverted, and is displayed by means of a small circle.

4.1.9

Step 9 - Set the Stop Signal after Exceeding the Second Time Limit

Create another network with the menu command Insert→Network (after).
add a Box of Type TON (function_block, switch-on delay) with the Name
network. Allocate the variable Warning to the IN input with the aid of the
constant T#5s to the PT input. After the Timer2 function block we need an
time to the variable Stop (Class VAR_GLOBAL).

© 2010 Beck IPC GmbH
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4.1.10 Step 10 - Insert POU for the Machine
Insert another POU with the name Machine, of type Program and with the Language SFC
(Sequential Function Chart) into the object organizer (the left hand area of CoDeSys), under POUs,
using the quick menu command Add object. The initial diagram of a POU in SFC consists of a step
"Init", and of a subsequent transition "Trans0" followed by a jump back to Init.
4.1.11 Step 11 - Specify the Machine’s Sequence
Each phase in the operation of our machine requires a step. Mark the transition Trans0 in such a way
that a dotted frame appears round Trans0, and use the quick menu to select the command StepTransition (after). Repeat this procedure five times. If you click directly on the name of a transition or
of a step it will be marked in blue and can be altered. The step after the Init step should be called
Go_Right, and the following steps Go_Down, Go_Left, Go_Up,and Count.
4.1.12 Step 12 - Programming the First Step
After a double click on the Go_Right step you will be asked about the desired Language. Select ST
(structured text) and a separate window appears for the action associated with this step. The machine
arm should be moved in the X-direction. The program line reads:
PauseT(IN:= TRUE, PT:= t#50ms);
After confirm the line with the return (Enter) key, choose the type TON for the PauseT Function Block.
You find that in Standard Function Blocks in the Standard.lib classified in the Timer folder. Now
type the next code lines below the line before:
IF PauseT.Q = TRUE THEN
PauseT(IN:= FALSE, PT:= t#1ms);
X_pos :=X_pos+1;
END_IF;
Completing the line “X_pos :=X_pos+1;” with a return (Enter), you have to declare the variable X_pos
having Type INT for integer. A small triangle appears in the upper left hand corner of the step to
indicate that this step has been programmed.
4.1.13 Step 13 - Programming the Next Steps
Repeat this procedure for the other steps with altered program lines, and as you do so declare the
variables Y_pos and Counter of Type INT.
In the Go_Down step:
PauseT(IN:= TRUE, PT:= t#50ms);
IF PauseT.Q = TRUE THEN
PauseT(IN:= FALSE, PT:= t#1ms);
Y_pos := Y_pos + 1 ;
END_IF;
In the Go_Left step:
PauseT(IN:= TRUE, PT:= t#50ms);
IF PauseT.Q = TRUE THEN
PauseT(IN:= FALSE, PT:= t#1ms);
X_pos := X_pos - 1 ;
END_IF;
In the Go_Up step:
© 2010 Beck IPC GmbH
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PauseT(IN:= TRUE, PT:= t#50ms);
IF PauseT.Q = TRUE THEN
PauseT(IN:= FALSE, PT:= t#1ms);
Y_pos := Y_pos - 1 ;
END_IF;
In the Count step (without the PauseT Function Block!) create a variable of type UDINT for example:
Counter := Counter + 1 ;
Note: The PauseT usage of the Function Block should slow down the execution time of the machine
to allow a sensible visualization of the project.
4.1.14 Step 14 - Specify Transitions
Transitions are the conditions for progressing from one phase to the next. Overwrite the first transition
after Init with the variable Start. In the declaration of variables enter the Class VAR_GLOBAL and the
Type BOOL. The machine thus starts to run when the start switch is pressed.
The second transition contains the condition X_Pos = 100, so that when the X-position has reached
the value 100 the next phase starts.
The third contains the condition Y_pos = 50.
The fourth contains the condition X_pos = 0.
The fifth contains the condition Y_pos = 0.
The sixth contains the condition TRUE (continue immediately after a single execution).

© 2010 Beck IPC GmbH
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4.1.15 Step 15 - Halt Processing at Stop
Go back to the PLC_PRG POU and insert a third network. Replace the question marks by the variable
Stop, and after that select the Return command from the context menu. The Return has the effect of
leaving the PLC_PRG POU when Stop is set.
4.1.16 Step 16 - Call Machine POU
Insert another network, set the focus there and execute in the command Box from the context menu.
The "AND" in the box is marked already. Press <F2> and in the input assistant dialog which appears,
select the machine POU in the User defined Programs category. This completes the programming.

© 2010 Beck IPC GmbH
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4.1.17 Step 17 - Build Project
Build the project with the menu command Project→Rebuild all, or the <F11> function key. In the
message window at the bottom right, „0 errors„ should be reported after the build procedure. If not,
check that all the entries have been correctly made. The reported error may also help.

4.2
4.2.1

A Visualization for This
Step 1 - Create Visualization

In the object organizer at the bottom left select the third tab from the left, named Visualization.
4.2.2

Step 2 - Use the Object Organizer’s quick menu to call the Add Object command.

Give the visualization object a Name, such as Observation. The visualization should finally look like
this:

© 2010 Beck IPC GmbH
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4.2.3

Step 3 - Draw Visualization Element

Let‟s start with the confirmation switch (the rectangle with the text OK in the figure). Select the symbol
for Rectangles from the toolbar. Press the left hand mouse key in the visualization editor, hold it
down, and draw a rectangle with it. Release the mouse key when it has reached the desired form and
size.
4.2.4

Step 4 - Configure the First Visualization Element

With a double click on the rectangle, the configuration dialog will appear. In the Contents field of the
Text Category write the text OK. Select the Variables Category, click in the Change Color field and
call up the input assistance with the <F2> function key. Make a double click to the point in the right
hand half of the dialog box and the global variable will appear. Select the Observer variable. The field
now contains .Observer.
After this, select the Colors Category in the configuration dialog, and click on the Inside button in the
Color area. Select a colour (e.g. light blue). Then select another colour with the Inside button in the
Alarm color area (e.g. blue).
In the Input Category select the Toggle variable point and again enter the variable Observer into the
field behind it with <F2>. Leave the configuration dialog.
This causes the rectangle to be coloured light blue during running operation when the Observer
variable is in the FALSE state, and blue when it is in the TRUE state. With each mouse click the state
is changed from TRUE to FALSE, or the other way around.
4.2.5

Step 5 - Expand Visualization

Draw a circle for the warning, and configure it with the following values:
Text Category, Contents field with Warning
Variable Category, Color change field with .Warning
Colors Category, Color area using Inside with colour grey, and Alarm color with red.
Copy the circle you have created using the menu command Edit → Copy and insert another one with
the menu command Edit → Paste. Alter the following values in the new circle:
Text Category, Contents field with the new entry Stop
Variable Category, Color change field with the new entry .Stop
Draw a rectangle for the start of the machine and configure it with the following values:
Text Category, Contents field with Start
Variable Category, Color change field with .Start
Input Category, select the point Toggle variable
Input Category, behind Toggle variable, enter .Start in the field
Colors Category, Color area using Inside with colour red, and Alarm color with green.
© 2010 Beck IPC GmbH
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Draw a rectangle for the counter and configure it with the following values:
Text Category, Contents field with Counter: %s
(%s functions as a place holder for the variable value)
Variable Category, Textdisplay field with Machine.Counter
Draw a rectangle for the machine and configure it with the following values:
Motion absolute Category, X-Offset field with Machine.X_pos
Motion absolute Category, Y-Offset field with Machine.Y_pos
Colors Category, Color area using Inside with colour blue.
If you like, you can draw two large rectangles around the two areas for observation and for the
Machine, enter Observation (or Machine) as the Contents in the Text Category, and select the
Vertical alignment bottom. Using the quick menu command Send to back place the rectangle behind
the existing elements.

4.2.6

Step 6 – Enable Web Visualization

If your IEC Platform supports the WebVisu feature, you can enable your visualization element for the
Web visualization. With the Web visualization you can show your visualizations created by CoDeSys
in a standard web browser (e.g. the Internet Explorer): make right mouse click on the visualization
element on “Object Properties” and enable the checkbox “WebVisu”. Repeat this on all elements
which should be part of the web visualization. The main element (the start page of the Web
visualization) must be named “PLC_VISU”. If you do not see the checkbox, your IEC Platform does
not support the Web visualization. The Website can be found under "http:\<TargetIP>\webvisu.htm".
®

Note for SC1x / DK51: The Web visualization requires a lot of flash memory on the IPC@CHIP . To
use the Webvisu the runtime system has to be started from a compact flash card or another external
storage memory, so the current working directory of the RTS points on it!
®
Also the webserver drive of the IPC@CHIP must be changed to the external storage memory. It is
done by adding the following lines to the CHIP.INI file which is located on the root directory on the
®
IPC@CHIP processor's flash:
[WEB]
DRIVE=1

For more information to the usage of a compact flash card have a look into the Getting Started Manual
®
for
the
IPC@CHIP
Embedded
Web
Controller
Family
documentation
on
http://www.beck-ipc.com/chip

4.3

Starting the Target System
®

To start the IPC@CHIP target system you have simply to switch the power supply on.

4.4

Settings for Establishing the Connection

A small number of settings must be made before we can establish the connection to the target
computer.
For this purpose carry out the menu command Online  Communication parameters.

© 2010 Beck IPC GmbH
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Select the button New to configure the connection to your target system.
Here you can configure the communication parameters for the serial as well as for the TCP/IP
communication with your target.
As a first step the TCP/IP communication is installed. Select the 'new' button in the 'communication
parameters' window.

Enter an appropriate name for the connection at the new dialog and select a connection (Serial or
TCP/IP).
© 2010 Beck IPC GmbH
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If you want to connect the target via serial connection, you have to choose the com port of your PC
which the Nullmodem cable is connected to. If you want to connect the target via TCP/IP, you have to
choose the IP address of the target.
After that close the communications parameters dialog with OK.

A further dialog window opens. The previously chosen name for the communication must be selected
®
under 'Channels'. In the field 'Value' (enter with double click) the IP-Address of the IPC@CHIP has to
be entered. The other standard settings such as 'Port' remain unchanged.
®
The IP Address of the IPC@CHIP can be set with the help of the integrated CHIP Find Dialog Tool.
®
To use this integrated tool open 'PLC configuration' under Resources. Select the IPC@CHIP module
®
and open the 'Module Parameter' window. All the IPC@CHIP processors present on the local
®
network are listed. Select the IPC@CHIP allowing adapting the configuration.

Editing of the value for "Address" must be terminated by pressing ENTER/RETURN on the keyboard
(not by pressing the "OK"-Button), otherwise the new value will not be adopted.
®
When TCP/IP configuration is done the communication with the IPC@CHIP can be established to
®
transfer the project as soon the Run Time System on the IPC@CHIP is started.
®

Note: If you want to modify the IP configuration of your IPC@CHIP target, you can do that by using
®
the Modul Parameters dialog in the PLC Configuration in CoDeSys. This dialog shows all IPC@CHIP
processors found on the local network. It also allows modification of the IP, Netmask or Gateway
addresses, or enabling DHCP.
© 2010 Beck IPC GmbH
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You can use the same procedure to initiate a serial configuration with the target. To do so, select the
button 'New' in the menu 'Communication Parameters', select a name for the communication and
select 'Serial(RS232)' as Device.

In the window 'Communication Parameters' the previously selected name must be selected. The value
under 'Port' defines the serial port of your Windows PC used for the communication with the target. On
®
the side of the IPC@CHIP the COM-Port is defined as standard for the serial communication with the
CoDeSys programming environment. The other settings in the menu remain unchanged. Click on 'OK'
to terminate the serial communication settings.
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4.5

Starting the Project

The program shall only demonstrate the variety of functionalities in CoDeSys and is not designed for
industrial usage. Please read this chapter once, before you try to figure out how to handle the IECprogram you created by means of the instructions before.
The connection to the target computer will be established using the menu command Online → Login
and you will be asked to download the program you just created. By means of the visualization you
can control the IEC-program. After downloading the program, your visualization should look like this:

Now start the IEC-program by selecting Online → Run from the CoDeSys menu (if you want to work
in simulation mode, the option 'Online' 'Simulation' must be activated).
In this demo-program "Observation" and "Machine" are operating almost independently from each
other. Once the program is running, the "Observation" is activated although the "Machine" seems to
do nothing. This leads to the following behaviour:

First the visualization element "Warning" and afterwards "Stop" become red. Don‟t' Panic, the program
remains in this state.
Now press the Machine's "Start"-button so that it switches it's colour to green. This will activate the first
transition of the "Machine" steps.
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And now press the "Observation's" "OK"–button, so that it switches it's colour to dark blue. The blue
rectangle, representing the machine arm, will start moving right.

After 10s the element named "Warning" will change it's colour to red again. This is the moment you
have been waiting for. Time for the machine operator to act!

You (the operator) have 5s left to signalize, that everything is ok and that the machine shall go on.
Therefore press "OK" once and its colour turns to light blue. Press it a second time and it becomes
dark blue again as well as the "Warning" turns back to grey. So every time a warning appears, "OK"
has to be presses two times and the machine will keep on moving.
If you let the five seconds pass without doing anything, "Stop" will become active (red) and the
machine stops moving.

Pressing "OK" two times will start moving again from the actual position.
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5

Multi-Tasking

If you are using SC1x (respectively the DK51), you can go on with chapter 6 , because Multi-Tasking
is not supported by SC1x runtime system.
So far (like in the Embedded RTS), the IEC-program runs as a single task on the target (comparable
to function main() in C)
CoDeSys offers the opportunity to create IEC-tasks. These tasks will be mapped to operating system
tasks (RTOS-tasks). Several jobs can be managed simultaneous by a set of (cooperating or
competing) IEC-Tasks. These tasks are prioritized and can be freewheeling, triggered by a timer or
activated by a boolean flag.
To give an illustration of Multi-Tasking in IEC, we will modify the "Observation-Machine"–project. First
make a copy of the project and save it to harddisk. Switch to the program in CoDeSys and select the
task configuration in the resource tab. All task management is done here.

Select "Task configuration" and open the context menu (right click on mouse). Select "Append Task".
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Give the NewTask the name and priority shown below and declare it as "freewheeling"

Now determine which program shall be executed, when the task is activated by the operating system:
Select "NewTask", open the context menu and select "Append Program Call".

© 2010 Beck IPC GmbH

Page 20 of 28

CoDeSys@CHIP
Getting Started V2.14
Press the button named "…" on the right and choose "PLC_PRG" from the "Input assistant".

The "ObservationTask" should now be associated with the "PLC_PRG".

Repeat this procedure with modified settings for the "Machine"-part of the IEC-program.

The PLC_PRG() represents the "Observation"-part of the IEC-Program. It has priority 10 (0 = highest,
31 = lowest) and is executed whenever no other program with a higher priority is ready. The Program
(PRG) named "Machine()" represents the machine-part of the IEC-Program. It has priority 5 (higher
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than PLC_PRG) and is executed every 10ms. Because of it's lower priority, the PLC_PRG will be
interrupted, when the "Machine"-task shall be executed.
Rebuild, download and run the modified program. This Multi-Tasking variant of the IEC-program
should almost behave like the single task version described in 4.5. But there is on difference: the
machine will not stop, when the operator failed to press "OK" in time, although "Stop"–element
becomes activated. Check this out!
This is due to the fact that the two IEC-programs run as two separate RTOS-tasks with no connection
to each other. In the single task version of the program, the "Machine"–program was executed by the
PLC_PRG. Now it is directly executed by the operating system. To get the tasks work together again,
the whole program must be adapted. Log out from the target and switch to the Machine PRG in the
Object Organizer's POU tab:

Switch to the editor and …
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… modifiy the steps "GoRight", "GoDown", "GoLeft" and "GoUp" in the following way:
PauseT(IN:= TRUE, PT:= t#50ms);
IF PauseT.Q = TRUE THEN
PauseT(IN:= FALSE);
IF NOT Stop
THEN
X_pos :=X_pos+1;
END_IF
END_IF;
Adding this if-clause to all steps will synchronize the two tasks again. The boolean flag "Stop" belongs
to the PLC_PRG, is set from there and reset from the visualization (respectively the"Observation"task). The "Machine"-task now polls this flag and depending on it's state, the machine's x- or y-position
is in- or decremented (respectively moved in the one or other direction).
At last switch to the PLC_PRG() and remove the box named "Machine" from the list of networks
(context menu  delete).

Rebuild, download and run the modified program. It should now behave in the same way as the first
(single-task) version.
Normally there is no need to split the original program into two tasks. This has only been done for
demonstrating how to proceed when creating IEC-Tasks. If you have more complex requirements in
programming a solution for an automation problem, the use of several IEC-tasks possibly makes more
sense. Maybe if your IEC-program needs functionality, where all emergency stops have to be scanned
in very short cycles, a high priorized, cyclic task may be the right choice. Or reading/writing from/to a
communication buffer in defined intervals could be done by an IEC-task as well.
Nevertheless for operating with several tasks within an IEC-project, many aspects of program design
must be considered:
avoid race conditions or deadlocks
choose the adequate task priority
choose practical watchdog settings
etc.
There are a lot of other features and settings relating to tasks, which can not be mentioned here. For a
more detailed explanation of IEC-tasks, take a look at 3S help.
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6

Accessing I/O-Modules via CANopen
®

With CoDeSys and the IPC@CHIP SC2x and SC1x3 it is very easy to access I/O-modules via
CANopen. This chapter will show you how to integrate the ILB CO 24 DI16 DO16 from Phoenix
Contact. It is a module with 16 digital inputs and 16 digital outputs.

6.1

Preparing the hardware

First of all you have to connect and configure the I/O module. Refer to its manual on how to supply it
with power and on how to configure its CAN node ID and the baud rate. In this example it will have the
node ID 1, the baud rate used will be 1 Mbit. Connect the CAN plug of the ILB CO 24 DI16 DO16 with
the one on the DK55 or DK60/EB60.

6.2

Creating a new project with CAN Master support

Create a new CoDeSys Project. In the Target Settings dialog select the development kit you use with
the addition “_CM” (e.g. “DK61_FP_CM”) where CM stands for CAN Master. If there‟s no configuration
with CAN Master support, you‟ll have to install the respective IEC Platform as described in chapter 3.
Note that if you have already installed an IEC Platform for the development kit without CAN Master
support, you‟ll have to uninstall this first using the CoDeSys Target Installer which can be found in the
Start Menu next to the CoDeSys shortcut.

Confirm the Target Settings dialog, then create PLC_PRG in the New POU dialog choosing ST as the
language.
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6.3

Configuring a CAN node

Select PLC Configuration from the Resources tab. In this dialog you will now configure the ILB CO 24
DI16 DO16 as a CAN node. To hand information on the module to CoDeSys you need to add the so
called Electronic Data Sheet to the project. This is a file with the extension .eds which you can
download from the website of Phoenix Contact. Choose Extras → Add configuration file… from the
main menu and select the EDS-file.
Expand the tree on the left side of the dialog until you see a node called “DK61_FP_CM_CO_M
[VAR]” (Of course the name will be slightly different if you‟re not working with a DK61). Select this
node and switch to the tab CAN parameters on the right side of the dialog. Set the baud rate to 1 MBit
and the Node ID to 0.

Now right-click on the node and select Append ILB CO 24 DI16 DO16 (EDS) from the popup-menu. A
sub-node called “ILB CO 24 DI16 DO16 (EDS) [VAR]” will appear in the tree. Select it and switch to
the CAN parameters tab again. Set the node ID to 1 here.
You‟ll notice that beneath the node for the I/O-module there are two more sub-nodes describing its
inputs and outputs. Remember the addresses of the first two input and output bytes. The tree holds
entries for four input and output bytes. This is because the Electronic Data Sheet is also used for other
variants of this module.
Open the window for the Global variables and add variables for the inputs and outputs of the ILB CO
24 DI16 DO16. The declarations should look like this:
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VAR_GLOBAL
canOutput0
canOutput1
canInput0
canInput1
END_VAR

AT
AT
AT
AT

%QB1
%QB2
%IB2
%IB3

:
:
:
:

BYTE;
BYTE;
BYTE;
BYTE;

Now the configuration of the module and its I/Os is complete and you may use them within your IECprograms.

6.4

Using the CANopen I/O-module

Open the program PLC_PRG and add the following simple code:
canOutput0 := canInput0 OR canInput1;
canOutput1 := canInput0 AND canInput1;
Compile, download and start the project. Apply some patterns to the input ports of the I/O-module and
check that they are put out ORed to the first and ANDed to the second output port.
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Appendix A

Additional Information

A.1 Where to find more information on the IPC@CHIP®
Check our website at http://www.beck-ipc.com
Here you will find application interfaces, tools, examples, new @CHIP-RTOS versions, etc.
®

®

Remember that the IPC@CHIP is an evolving product. It makes sense to visit the IPC@CHIP home
page regularly.

A.2 Where to get support
There are two possible ways to get support:
1. To get support please use our newsgroup on the Internet:
®
You can visit the IPC@CHIP forum at http://www.beck-ipc.com/ipc/support/forum. Here you will
find a lot of answers to customer problems and you can also add your own ideas and questions.
Please use email as the main way of communication. This not only reduces the time you spend on
the phone, but also allows us to easily manage the questions and identify problem areas.
Important or frequent questions and the corresponding answers are becoming part of our
„Frequently asked question list‟ that is published on the Internet.
2. To get support via email:
Please send your emails with your request to mailto:support@beck-ipc.com
You will find also a lot of answers in our Frequently Asked Questions documentation at
http://www.beck-ipc.com/ipc/support.

A.3 Order numbers
A.3.1

SC1x-Series

The SC11/SC13 processors and any part of the DK51 Development Kit can be ordered separately.
Please visit our Online Shop. The order numbers are:
CHIP:
SC11
SC11 LF (lead free)
SC13
SC13 LF
538823
539361
195837
538934
20042110

A.3.2

Without IEC License:
538428
543327
536079
542546

With IEC License:
539384
543328
540553
542752

DK51 Development Kit
DK50 Development Board
ZK14 programming cable for DK50
PSE10 power supply for DK50
Borland C++ 5.02 SDE

SC2x Series

The SC23 processor and any part of the DK5 Development Kit can be ordered separately. Please visit
our Online Shop. The order numbers are:
CHIP:
SC23 (lead free)
SC24 (lead free)
553947
553946
© 2010 Beck IPC GmbH

Without IEC License:
553944
566821

With IEC License:
553945
566822

DK55 Development Kit
DB54 Development Board
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195837
538934
541522

A.3.3

ZK14 programming cable for DK61
PSE10 power supply for DK60
Paradigm C/C++ Compiler Beck IPC Edition

SC1x3-Series

The SC123/SC143 processors and any part of the DK61 Development Kit and the EK61 Software
Evaluation Kit can be ordered separately. Please visit our Online Shop. The order numbers are:
CHIP:
SC123
SC123 LF (lead free)
SC143
SC143 LF
542750
542751
195837
538934
541522
547953
547954
547955

Without IEC License:
541094
543257
541529
543258

With IEC License:
541528
543259
541530
543260

DK61 Development Kit
DK60 Development Board (with SC143-IEC)
ZK14 programming cable for DK61
PSE10 power supply for DK60
Paradigm C/C++ Compiler Beck IPC Edition
EK61 Software Evaluation Kit
EB60 Software Evaluation Board (with SC143-IEC)
Paradigm C/C++ Compiler Beck IPC Edition Demo

End of this document
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